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Exam e 

QUESTION 1 

A designer needs to create a chart displaying the number of patients currently checked into a hospital by age group. What 

is the appropriate Dimension for the chart? 

A. number of patients 

B. checked-in status 

C. hospital 

D. age group 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 2 

A customer needs to measure the Amount of Sales by Days Sales Outstanding (DSO). Days Sales Outstanding does not exist in the data model. Which technique should a developer use to meet the customer's need? 

A. on the Dimensions tab, press the Add Calculated Dimension button B. 

on the Expressions tab, add an expression using the Class function 

C. on the Expressions tab, add an expression using the Aggr function 

D. on the Dimensions tab, press the Add Dynamic Dimension button 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 3 

A customer needs multi-language support for a QlikView application. 

The languages that need to be supported immediately are English, German, and Dutch; in the future, however, additional languages may be needed. Which 

solution should a developer use to meet the customer's needs? 

A. a separate document for each language 

B. variables for language-specific items and the option to select a specific language in a field 

C. a language definition table in the data model containing all descriptions for each language, and the option to select a specific language in a field 

D. a language definition table in the data model containing all descriptions for each language, automatically linking the business user to a language 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 4 

A customer needs to have QlikView deployed to tablet devices. 

When creating the QVW application, which two actions must a developer take to meet the customer's need? (Choose two.) 

A. convert the QVW application into a .mob document on the server 

B. ensure that screen resolution is appropriate for the device 

C. convert the QVW application into a HTML5 document 
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D. create a specific QVW application for each device 

E. use only sheet objects suitable for tablet devices 

Correct Answer: BE 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 5 

A customer needs to produce formatted output as a PDF to distribute it to non-QlikView users. Each page should show sales trending for a different sales team. The number of sales teams will change frequently. What should a developer 

create to efficiently enable users to create the required output? 

A. a report with banding on SalesTeam 

B. a report with GROUP BY on SalesTeam 

C. separate reports with where clauses for each SalesTeam 

D. separate reports referencing bookmarks for each SalesTeam 

E. a report that uses current selections where the user selects each SalesTeam in turn 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 6 

A global sales organization needs sales figures in both the local currencies and the corporate standard of $USD. 

How can a developer achieve this goal and enable users to only consume a single Document CAL? 

A. create a separate QVW containing values in the data model for both the local and $USD currency amounts 

B. create a single QVW and add a table containing currency multipliers while using $USD as a baseline currency 

C. create a separate QVW for each currency ($USD is considered its own currency) and document chain them all together 

D. create a single QVW with duplicate tables for each currency in data islands and associate each data island to each user or group 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 7 

Refer to the exhibit to the right. 
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Which two data quality issues exist within the data set displayed in the exhibit? (Choose two.) 

A. multiple spellings of the same City 

B. the City value London is associated with two different Country values 

C. the Country values and SalesOrderID values do not relate properly 

D. the SalesAmount field name does not contain a space 

E. inconsistent Country abbreviations 

F. duplicate key values 

Correct Answer: AE 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 8 

Refer to the exhibit to the right. 
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A customer needs the data displayed in the exhibit loaded into QlikView for analysis. 

The data is stored in a flat file and new rows are appended daily. 

Which two data quality issues will a developer have to resolve? (Choose two.) 

A. the Transaction ID field name contains a space 

B. one or more Product field values contain spaces 

C. the Date field values contain special characters 

D. one or more header rows are included in the file data 

E. one or more Product field values contain the file delimiter 

F. the Date field name is also a function name and is a reserved word 

Correct Answer: DE 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 9 

Refer to the exhibit to the right and the Load Script provided below. Exhibit. 
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LOAD ItemID, 

LocationID, 

Quantity 

FROM 

[inventory.txt] 

(txt, codepage is 1252, embedded labels, delimiter is ',', msq); 

When the developer runs the script, which values will the field Quantity contain? 

A. NULL 

B. 1; 2; 3 

C. 1100; 1300; 2210; 2250; 3125; 3130; 3120 

D. 1,100; 1,300; 2,210; 2,250; 3,125; 3,130; 3,120 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 10 

A customer has a set of date values in different formats. 

Some dates are in Julian date format; some dates are text strings. 

How can a developer ensure the data is loaded in a consistent format? 

A. change the default DateFormat variable assignment on the Main script tab 

B. use the Date function to format the field during load 

C. use the Alt function with different Date# functions 

D. use the Lookup function with a format table 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 11 Which statement describes a required field characteristic that will ensure QlikView associations across 

multiple tables? 

A. The field formats (such as numeric or string) must be the same in the original data sources. 

B. The fields must be defined as primary or foreign keys in the original data sources. 

C. The fields must be aliased to the same name when loading into QlikView. 

D. The number of distinct values in each field must be the same. 

Correct Answer: C 

Section: (none) 
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Explanation 

Explanation/Reference: 

QUESTION 12 Which action should a developer perform on a table to reduce required memory and optimize 

the application? 

A. convert numeric fields into text fields using the Text function 

B. combine multiple fields into one complex field, reducing the number of fields per table 

C. make all numeric fields a fixed length by left padding with leading 0's using the Num function 

D. split out a single complex field into multiple fields reducing the number of distinct values per field 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 13 

Refer to the exhibit to the right. 

 

What is the primary key of ACCOUNT_TRANS? 

A. ACCOUNT_ID 

B. TRANS_SEQ 

C. ACCOUNT_ID and TRANS_SEQ 

D. ACCOUNT_ID, TRANS_SEQ, and TRANS_TYPE 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 14 

Refer to the exhibit to the right. 
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What is the cardinality of the relationship between CUSTOMER and ACCOUNT? 

A. many-to-many 

B. one-to-many 

C. one-to-none 

D. one-to-one 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 15 

Refer to the exhibit below. 

 

Schema A displayed in the exhibit has been transformed into Schema B. How can the before and after schemas be described? 

A. The snowflake schema has been transformed into a de-normalized schema. 

B. The snowflake schema has been transformed into a normalized schema. 

C. The star schema has been transformed into a de-normalized schema. 

D. The star schema has been transformed into a normalized schema. 

Correct Answer: A 
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Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 16 

Refer to the exhibit below. 

 

The tables displayed in the exhibit need to be loaded into QlikView. How 

will the data model appear once the load is complete? 

A. There will be a relationship between all the tables without synthetic key tables or loosely coupled tables. 

B. There will be a relationship between four of the five tables and one table will be a data island. 

C. There will be a synthetic key table in the data model. 

D. There will be loosely coupled tables in the data model. 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 17 

A client has a data set with two tables. 

The Customer table has fields CustomerID, AssignedTo, FirstName, and LastName. The Orders table has fields CustomerID, AssignedTo, Product, and Quantity. The 

AssignedTo field holds an employee reference. 
Users need to see Customers and Orders by employee. 

The employee assigned to the Customer may not be the same as the employee assigned to the Order. Which 

technique should be used in the script to meet the requirement? 

A. load the tables leaving the automatic associations 

B. comment out the AssignedTo from the Orders table 

C. comment out the AssignedTo from the Customer table 

D. use Rename Field syntax to alias one of the AssignedTo fields 

E. create a concatenated key of CustomerID and AssignedTo in both tables 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

www.vceplus.com - Free Questions & Answers - Online Courses - Convert VCE to PDF - VCEplus.com



QUESTION 18 

Refer to the exhibit. 

 

A customer needs to analyze transactions across the Dimensions and Metrics identified below. 

Required Dimensions: 
Project ID 

Month 

Year 

Account ID 

Transaction Type 

Client ID 

Required Metrics: 

Number of transactions 

Total Amount 

Total Cost 

Average Amount 

Average Cost 

Which approach will provide the most effective QlikView data model to meet the customer's requirements while optimizing performance and maintaining accuracy? 

A. build a Link Table to connect the four transaction tables and add a summary table with pre-calculated counts, totals, and averages 

B. build a Link Table to connect the four transaction tables and alias fields that must be kept in their respective table 

C. concatenate the four transaction tables and add a summary table with pre-calculated counts, totals, and averages 

D. concatenate the four transaction tables and add fields to identify the record type and count flag 

E. keep the four transaction tables separate and qualify the names to control correct linkage 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 19 

Refer to the exhibit to the right. 

 

A customer has aggregated budgets for products by year and month. Actual data is stored at a more detailed transaction level and so a one-to-many relationship exists between the Budgets to Actuals table. 

Budgets have been assigned for all months of the current year, but there are only transactions up to the current month of October. There are transactions for products that were not assigned budgets. How 

can a developer remove the synthetic key automatically generated by QlikView and be able to analyze budgets and actuals by product, month, and year? 

A. load the Actuals table, and when loading the Budgets table, use Outer Join to join the BudgetAmount field to the Actuals table 

B. load the Actuals table, and when loading the Budgets table, rename fields Year and Month to BudgetYear and BudgetMonth 

C. load the Actuals table, and when loading the Budgets table, use the Concatenate function to append the Budgets table to the Actuals table 

D. create a concatenated key of Product-Year-Month in both the Budgets and Actuals table and comment out the individual fields in the Budgets table 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 20 

A developer needs to add data from a Microsoft Access database to a data model intended to run on a 64 bit Windows Server. How 

should the developer proceed? 

A. from the script editor, on the Data tab, under Database, choose 'ODBC' from the Database pull down, assure the 'Force 32 bit' check box is selected, and then click the 'Connect' button 

B. from the script editor, on the Data tab, under Database, choose 'ODBC 32 bit' from the Database pull down and then click the 'Connect' button 
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C. from the script editor, on the Data tab, click on the 'database conversion' button and convert the database from a 32 bit to 64 bit databaseD. from the script editor, on the Data tab, under Database choose 'ODBC' from the Database pull 

down and then click the 'Connect' button 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 21 

A customer needs to analyze Products by Product Grouping. The relationship between Product and Product Group is undefined in the original data source. How 

can the Product Grouping be defined within the QlikView script? 

A. by using Input Box to enter the lookup table 

B. by using AutoGenerate to load the lookup table 

C. by generating a lookup table using the Inline wizard 

D. by loading the lookup table using an Include statement 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 22 

A customer has sales data containing a fact table, Sales and dimension tables, Customer, Item, and Vendor. 

After loading the data, the Entity Relationship Diagram (ERD) has a synthetic table containing the fields Name and Address from the Vendor and Customer tables. How 

can a developer eliminate the synthetic keys and appropriately link the data? 

A. qualify all tables 

B. alias all primary key fields 

C. left join the Customer data onto the Sales table 

D. qualify all tables and then unqualify all key fields 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 23 

A customer has an Actual Sales fact table aggregated at the transactional level and a 

Budgeted Sales fact table aggregated at the monthly level. The tables share many of the same dimensional fields. 
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How can a developer form the data model? 

A. qualify both tables and Unqualify all shared fields 

B. left join the Budgeted Sales table onto the fact table using Month as the key 

C. concatenate Load the Budgeted Sales table into the Actual Sales table loading shared fields as NULL 

D. create a link table containing the dimensional fields then link each fact table using a concatenated key 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 24 

Refer to the exhibit to the right. 
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Which technique should be used by a developer to eliminate the circular reference in the data model displayed in the exhibit? 

A. qualify all the fields in the data model ending with 'ID' 

B. qualify the fields Name, Address, City, and Country in the Shippers and Suppliers tablesC. rename the fields ShipperID in the Shippers table and SupplierID in the 

Suppliers table 

D. rename the fields OrderID in the OrderDetails table and SupplierID in the Products table 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 25 

A customer has 30 target values that are used to evaluate the quality of an organization's facilities. At least half the target values are changed monthly by the business users. What 

is the most efficient way for the developer to store, access, and maintain the target values? 

A. save the target names and values in an external file, load them into a QlikView table, and use a FOR loop to assign the values to variables 

B. manually create a variable for each value in Expression Overview and maintain them in Expression Overview 

C. create a Variables tab in the load script and use 30 LET statements to assign the values to variablesD. embed the target values into each expression in which they are required 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 26 

A customer created 20 expressions that will be used repetitively throughout a QlikView application. These expressions could appear in more than 50 objects located on 15 tabs. How 

can a developer efficiently apply and maintain these expressions? 

A. create the required expression in each object as needed and edit them in the Expression Overview 
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B. load the text for each expression from a text file into a table in the data model and link it to the fact table 

C. create a table of indices and expression text and use the index value in place of the expression text in each object 

D. create a variable for each expression that contains the expression text and use the variable in place of the expression in each object 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 27 

Refer to the exhibit to the right. 

 

What can a developer determine from the exhibit about the values in the Fax field? 

A. The Fax field has NULL values for 24 percent of the records. 

B. The Fax field has blanks for 24 percent of the records. 

C. The Fax field has 76 percent incomplete/invalid fax numbers. 

D. On average, 76 percent of the Fax field values are non-spaces. 

E. The longest Fax value is 76 percent of the assigned field length. 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 28 

Refer to the exhibit below. 
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A QlikView report does not match the legacy report it was designed to replace. The purpose of the report is to count the number of customers per year and in total. Why 

is there a difference between the Total row values in the two reports? 

A. The legacy report calculates the total customer occurrences, while the QlikView report counts only distinct customers. 

B. The legacy report calculates the total customer occurrences, while the QlikView report calculates the customer ranking. 

C. The legacy report totals the number of customers correctly, while the QlikView report is dropping records. 

D. The legacy report totals the number of customers correctly, while the QlikView total row is set to Sum of rows. 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 29 

Which QlikView script should a developer add to a Load script to output the resulting number of rows from a joining Load statement to the Script Execution Progress window and the script log file? 

A. LET vNumRows = NoOfRows('TableName'); ECHO 'Resulting Rows = $(vNumRows)'; 

B. SET vNumRows = NoOfRows('TableName'); ECHO 'Resulting Rows = $(vNumRows)';C. LET vNumRows = NoOfRows('TableName'); PRINT 'Resulting Rows = 

$(vNumRows)'; 

D. SET vNumRows = NoOfRows('TableName'); Response.Write 'Resulting Rows = $(vNumRows)'; 

E. LET vNumRows = NoOfRows('TableName'); TRACE 'Resulting Rows = $(vNumRows)'; 

Correct Answer: E 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 30 

A developer made several changes to a 25-tab load script that normally runs for at least two hours. Which 

step should the developer take first to efficiently debug the script logic? 

A. place a Go To Exit statement after each block of revised script code, run the script, and comment each successive Go To Exit after a successful run 

B. move each revised tab in succession to the second tab position, place an Exit Script statement at the end of the tab script, and run the script 

C. open the QlikView Debugger and use the Step button to execute each line of the script 

D. open the QlikView Debugger and use Limited Load to execute the script 

Correct Answer: D 

Section: (none) 
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Explanation 

Explanation/Reference: 

QUESTION 31 

Refer to the exhibit to the right. 

 

When a customer reloads the script displayed in the exhibit, it fails to respond and complete, and displays an error message. 

OBJECT OUT OF MEMORY. 

How should the developer resolve the logic error in the script? 

A. change the script to use an Inner Join instead of Left Join 

B. change the QUALIFY * command to list out only the fields that need to be qualified 

C. change the Left Join command to include the name of the table being joined enclosed in parentheses 

D. change the DepartmentID field in the SalesPerson table to match the qualified field name of DepartmentID in the Department table 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 32 

Refer to the exhibit to the right. 
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When the script displayed in the exhibit is reloaded, an error message is displayed. 

Table not found 

Left Join (SalesPerson) 

LOAD ID, 

DepartmentID 

FROM 

[DataSourceA.xlsx] 

(ooxml, embedded labels, table is SalesPersonDepartment); 

What is the likely cause of the error? 

A. When loaded, the SalesPerson table is auto concatenated to Customer and does not exist when referenced. 

B. The Left Join statement fails to correctly bracket the referenced table name, such as Left Join ([SalesPerson]). 

C. The Left Join statement fails to correctly quote the referenced table name, such as Left Join ("SalesPerson"). 

D. There is an error in the Customer table load and it is not created in memory. 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 33 

A project to develop a QlikView application for a customer requires splitting developers into two teams. 

One team will focus on developing source database query knowledge to create a reusable data layer. There are several application-specific business rules for this project. The customer needs to incrementally accumulate history for the 

QlikView application over time. 

The second team will focus on developing the presentation layer. This team also has data modeling and scripting expertise, but does not have source database query knowledge. Which 

data loading strategy should the developers use on the project? 

A. create a series of QVWs that apply the business rules and then binary load them into the presentation layer QVW 

B. create the presentation layer QVW and connect directly to the source data and apply the business rules in the script 

C. create QVDs of the source data and load them into the presentation layer QVW and apply the business rules in the script 
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D. create QVDs of the source data, apply the business rules and store a second layer of QVDs, and then load these QVDs into the presentation layer QVW 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 34 

A customer needs to build a QlikView application using data in text files. A new data file is created every day and stored in a folder on the customer's network named s. \userfiles. 

The file name is in the form dataYYYYMMDD.txt, where YYYYMMDD represents the current date, such as data20111231.txt. Which 

data load strategy should a developer use to load all of the customer's data files each day? 

A. the statement 'Directory s. \userfiles\*;' preceding the Load statement 

B. the 'Wildcard Load' feature by setting the 'File Location' in Document Properties 

C. 'Load * From [s. \userfiles\data*.txt] (ansi, txt, delimiter is '\t', embedded labels);' 

D. 'Load * From_Field (s. \userfiles\, 'data*.txt') (ansi, txt, delimiter is '\t', embedded labels);' 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 35 

A customer needs a better understanding of inventory trends over time. However, the source database contains only the current product inventory levels. Which 

technique will take advantage of QlikView capabilities to meet the customer's needs? 

A. using a QlikView script to store an accumulation of periodic snapshots to a table in the source database 

B. using a QVD file to store an accumulation of periodic snapshots from the source database 

C. using a QVX file to store an accumulation of periodic snapshots from the source database 

D. using a QlikView script to store an accumulation of periodic snapshots to an XML file 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 36 

A customer's product catalog database contains approximately 50,000 individual product SKUs. The catalog is updated quarterly. 

The customer needs the load on database servers to be minimized. 

Which technique should a developer use to meet the customer's needs? 

A. a preceding load statement when loading the product catalog quarterly from the customer's database 

B. the BUFFER statement when loading the product catalog quarterly from the customer's database 

C. a mapping table when loading the product catalog quarterly from the customer's database 

D. a QVD file to store the product catalog quarterly from the customer's database 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 37 

How does QlikView link a fact table and dimension table in the associative data model? 

A. identically to all table linkages created in a relational database 

B. on a field called "<tablename>.id" created by the developer in every table 

C. on an identically named field in both the fact table and the dimension table 

D. by manually setting the field property Keyfield on one field in both the fact table and the dimension table 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 38 

What is the interpretation of a 98 percent subset ratio in the CustomerID field in an Orders table when the subset ratio of the same field in the Customer table is 100 percent? 

A. 98 percent of the orders have customers in the data, but only 2 percent of the orders have been shipped 

B. 2 percent of the orders have customers in the data, but 100 percent of the customers have placed an order 

C. 100 percent of customers are defined in the Customer table, but 2 percent of the customers have not placed an order 

D. 98 percent of the customers are defined in the Customer table, but 2 percent of the customers have not placed an order 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 39 

Refer to the exhibit to the right. 
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A customer has two databases containing employee data for different regions. 

Based on the script displayed in the exhibit, what will be the resulting table schema? 

A. one table named Employees_US 

B. one table named Employees_UK 

C. two tables named Employees_US and Employees_UK with no associations 

D. two tables named Employees_US and Employees_UK with a synthetic key 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 40 

A customer has a Sales data table and needs a chart to display sales figures by date, including dates without sales. 

The Sales table is sorted by the primary key which is generated based on the type of order and the SalesPersonID who generated it. Which 

technique should a developer use to achieve this requirement? 

A. a Resident Load and Peek, to determine the minimum and maximum dates and then AutoGenerate to create a master calendar 

B. the today() function, to determine the required date range and use an Inline load to generate the master calendar 

C. Peek, when loading the Sales data, to create records within the Sales data table for dates with no salesD. calculated dimensions in Chart Objects and expressions in List Boxes, to generate the required dates 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 41 

An Address Book table has a Country Code field. A standard lookup table exists in Excel to translate the Country Code to a Country description. 

The Country Code will be US for any Address Book record with no Country Code value. 

Which technique should a developer use to ensure a Country description is loaded for all Address Book records? 

A. load the Address Book records and perform a Left Join of the Excel data to the Address Book table 

B. load the Excel data and then load the Address Book data ensuring the Country Code field has the same name in both tables 

C. load the Excel data as a Mapping table and use Applymap with a default mapping value when loading the Address Book table 

D. load the Excel data, then load the Address Book data using an If function to default Country Code to US, and then use the Peek function to retrieve the Country description 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 42 

A developer needs to load an Account table and a Contact table from QVDs. The developer needs to load only contacts for the accounts that have already been loaded. 

There may be more than one contact for an account, so the developer needs to keep the Account and Contact tables separate. After 

loading the Account table, which function should the developer use in the Where clause of the Contact table load? 

A. Previous 

B. Match 

C. Exists 

D. In 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 43 

A customer has data tables for financial results, staffing, sanitary conditions, and customer satisfaction. Each table contains a date field and a location ID. Not all dates appear in all tables. How 

can a developer create a master calendar that can be used with all the tables? 

A. Designate one of the date fields as the reference Build a calendar spanning the minimum and maximum dates in that table Rename all other date fields to match the reference field Left join the location ID from each table into thecalendar 

table on the date fields Drop the location and date fields from all other tables 

B. Find the minimum and maximum dates spanned by all tables Create a calendar spanning those dates Rename all other date fields to match the reference field Left join the location ID from each table into the calendar table on the 

datefields Drop the location and date fields from all other tables 

C. Designate one of the date fields as the reference Build a calendar spanning the minimum and maximum dates in that table Rename all other date fields to match the reference field Create a link table with a key of Location and date 

thatcontains all unique locations and dates Create a key of location and date in the other tables 

D. Find the minimum and maximum dates spanned by all tables Create a calendar spanning those dates Create a link table with a key of location and date that contains all unique locations and dates 

Create a key of location and date in the other tables Drop the location and date fields from all other tables 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 44 

Refer to the exhibit to the right. 
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How many rows and fields will TableA have after the script completes? 

A. five rows and three fields 

B. five rows and two fields 

C. four rows and three fields 

D. four rows and two fields 

E. two rows and three fields 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 45 

A developer needs to load data for products from a database table and a text file. The database table and text file can be joined by the field ProductID The 
database table contains the master list of all available products. The text file contains additional data fields, but not for all products. 

The developer loads the data from the database table first. 

The developer needs to load the additional data fields from the text file into the existing table. The resulting table needs to contain the master list of all available products. Which 

type of join should the developer use when loading the text file? 

A. Inner Join 

B. Left Join 

C. Right Join 

D. Outer Join 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 46 

What must a developer consider when loading a table after the Section Access statement and before the Section Application statement? 
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A. All field names must start with a $ sign. 

B. All field names must be written in uppercase. 

C. The field Access must be the first field loaded. 

D. The fields Access, User, and Password must be loaded. 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 47 

Refer to the exhibit to the right. 

 

The Sales table displayed in the exhibit represents the entire data set. Given the expression. =sum(Given the expression. 

=sum( {$< Month={'Oct'}, RegionID={'4'} >} SalesAmount) 

What is the result with the selections for SalesPersonID=1 and RegionID=3? 

A. 0 

B. 3500C. 4500 

D. 5000 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 48 

A customer is building a dashboard to measure the performance of the Support organization. 

The customer needs to dynamically sort the Ticket Severity field by Severity Weight field when the Ticket Severity column header is double-clicked in Straight Table charts. Example 

ticket severities. 
Urgent = 1 
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High = 2 

Normal = 3 
Low = 4 

Which QlikView load script function can the developer use to create the Ticket Severity field to meet the customer's needs? 

A. Rank( [Ticket Severity], [Severity Weight] ) AS [Ticket Severity] 

B. Num( [Severity Weight], [Ticket Severity] ) AS [Ticket Severity] 

C. Sort( [Ticket Severity], [Severity Weight] ) AS [Ticket Severity] 

D. Dual( [Ticket Severity], [Severity Weight] ) AS [Ticket Severity] 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 49 

A customer specified that the QlikView application should be designed to fit a screen resolution of 1280 x 800 as a standard. Which 

option will assist a designer while creating the user interface? 

A. Go to View menu > Resize Window > 1280 x 800 

B. Go to View menu > Fit Zoom to Window > 1280 x 800 

C. Go to Settings menu > User Preferences > Design Tab and select 1280 x 800 

D. Go to Settings menu > User Preferences > Design Tab and select Display Grid Lines 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 50 

In which two places in the Chart Properties of a Gauge can expressions be entered? 

(Choose two.) 

A. Calculation Condition of the object 

B. Number of major/minor units for the scale 

C. Show Condition of the object 

D. X and Y position of the object 

E. Auto Minimize of the object 

Correct Answer: AC 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 51 How can a designer display the field selections that have been made within 

a chart caption? 

A. by inserting a Current Selections box into the Text in Chart 

B. by using an expression with GetCurrentSelections in the Window Title option on the General tab 

C. by using an expression with Set Analysis and the System Fields in the Title Text option on the Caption tab 

D. by selecting Show Current Selections on the Caption tab 
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Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 52 

An Invoices table has a DaysOverdue field. A chart is required to analyze overdue invoices in 30 day intervals. Which 

function should a designer use within a chart to meet this requirement? 

A. Class(DaysOverdue,30) 

B. Aggr(DaysOverdue,30) 

C. GroupBy(DaysOverdue,30) 

D. IntervalMatch(DaysOverdue,30) 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 53 

A customer has an Addresses table with the fields. CustomerNumber, CustomerName, AddressLine1, AddressLine2, City, StateCode, PostalCode, and CountryCode. 

A designer needs to design a chart to show a count of distinct customers in which the customer's CountryCode is US or CA, while ignoring all selections on the Addresses table except the CustomerNumber and CustomerName fields. How 

can the designer calculate the required value? 

A. count({$<CountryCode={US, CA}, Addresses.*=>} distinct CustomerNumber) 

B. count({$<CountryCode={US, CA}, AddressLine1=, AddressLine2=, City=, StateCode=, PostalCode=>} distinct CustomerNumber) 

C. count({1<CountryCode={US, CA}, CustomerName=CustomerName, CustomerNumber=CustomerNumber>} distinct CustomerNumber) 

D. count({$<CountryCode={US or CA}, AddressLine1=, AddressLine2=, City=, StateCode=, PostalCode=>} distinct CustomerNumber) 

E. count({$<(CountryCode={US} or CountryCode={CA}), AddressLine1=, AddressLine2=, City=, StateCode=, PostalCode=>} distinct CustomerNumber) 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 54 

A customer's data set contains information for multiple departments. 

The customer needs a document to show only one specific department when a user first accesses the application. Which 

trigger and action will meet the requirement? 

A. trigger. OnPostReload; action. Lock Field 

B. trigger. OnOpen; action. Set Variable 

C. trigger. OnOpen; action. Select in Field 

D. trigger. OnSelect; action. Select in Field 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

www.vceplus.com - Free Questions & Answers - Online Courses - Convert VCE to PDF - VCEplus.com



QUESTION 55 

Which object should a designer use to integrate QlikView with an interactive third-party web service for use in the AJAX Zero Footprint client? 

A. Custom Object 

B. Button Object 

C. QlikView Macro 

D. Extension Object 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 56 Which objects are the most appropriate for setting one or more values for use in a 

"what-if" scenario? 

A. Input Box Object and Chart Object 

B. Input Box Object and Calendar/Slider Object 

C. Button Object and Extension Object 

D. Calendar/Slider Object and Chart Object 

E. Input Box Object and Text Object 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 57 

Which chart should a designer use to display orders, sales, and average order value grouped by year, quarter, region, product, and salesperson? 

A. Pivot Table 

B. Straight Table 

C. Grid Chart 

D. Mekko Chart 

E. Bar Chart 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 58 

A customer needs to display sales amounts for the current month and a trend of sales over the prior 12 months using a small amount of screen space. Which 

chart type should the designer use to meets the customer's needs? 

A. a Combo Chart with one expression to display the current month sales and a second expression represented as a Mini Chart to display a trend of sales over the prior 12 months 

B. a Straight Table with one expression to display the current month sales and a second Line Chart to display a trend of sales over the prior 12 months 

C. a Straight Table with one expression to display the current month sales and a second expression represented as a Mini Chart to display a trend of sales over the prior 12 months 

D. a Straight Table with one expression to display the current month sales and a second expression represented as a Linear Gauge to display a trend of sales over the prior 12 months 

Correct Answer: C 

Section: (none) 

Explanation 
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Explanation/Reference: 

QUESTION 59 

A customer with a complex chart is experiencing performance issues when the organization's users view the chart without first applying several filters. 

A designer needs to place a restriction on the chart so that the users are forced to make a selection before QlikView will calculate and render the chart. Which 

common object property can the designer use to accomplish this? 

A. the Help Text property on the Caption tab to enter instructions directing the user to make a selection and filter their data before performing their analysis 

B. the Auto Minimize property on the Caption tab so that the chart will be minimized and not calculate or render until the user has first made a selection and restored the chartC. the Calculate Condition 

property on the General tab to create a control condition that will keep the chart from calculating until user has filtered the data D. the Size to Data property on the Layout tab to automatically size the filter 
criteria to the chart 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 60 

A customer has multiple bar charts comparing different metrics. All charts contain a single Expression all with the Dimension CustomerID 

The charts are sorted by Y-Value Descending. Some Customers have Y-Values of zero for some metrics and not others. How can the 

designer show the same color bar for a single CustomerID in all the charts? 

A. Properties > Colors and then define colors 1 - 6 with specific RGB values 

B. Properties > Colors and then check the Multicolored and Persistent Colors checkboxes 

C. Properties > Visual Cues and then set the Upper and Lower colors using specific RGB valuesD. Properties > Presentation and then define the Error Bars colors with a specific RGB value 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 61 

A Straight Table Chart calculates several metrics for each individual alphanumeric transaction detail record (TRAN_ID) and its Amount over several years of data. The calculation time for the chart is over two minutes. How 

can a designer decrease the calculation time for the chart without compromising core functionality? 

A. create a Calculation Condition. =count(TRAN_ID) <= 10000 

B. create a Calculation Condition. =sum(TRAN_ID) <= 10000 

C. create a Calculation Condition. =sum(Amount) > 0 

D. create a Calculation Condition. =TRAN_ID < 10000 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 62 How can a developer use QVD files to optimize 

reload performance? 

A. create an incremental load strategy that reduces the query sizes against the source data 

B. decrease latency between the QlikView reload engine and the source data 

C. enable a direct interface between the database server memory and the QlikView server memory 

D. enable the binary load functionality and directly load files in binary from the hard disk into system memory 
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Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 63 

A customer needs an application to reload in a short time period. The source tables are log files that are appended to on a daily basis. Which 

performance tuning option should a developer use? 

A. the QVD files to store the source tables 

B. the Partial Reload command with the append option 

C. the Load prefix Buffer with the incremental option 

D. the Load prefix Buffer and set the Keep Outdated QVD Buffers in the Document Properties 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 64 

A developer has a Container Object with multiple charts and each chart has many different expressions. 

The developer needs to provide users with a method to easily obtain information related to each chart and the expressions within. How 

can the developer fulfill this requirement? 

A. design a help graphic for each chart and set it as the caption background 

B. create a Text Object containing help information for each chart and link each Chart Object to its corresponding Text Object using QlikView's Linked Objects feature 

C. enter a thorough description of each chart and its expressions in the Text in Chart property on the Layout tabD. enter a thorough description of each chart and its expressions in the Help Text property on the Caption tab 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 65 

Which technique should a developer use to clearly describe dimensions and measures for end users who need to use collaborative objects? 

A. add field metadata tags to fields in the load script 

B. put a How To sheet in the application 

C. put descriptive information in each object's help text 

D. add a system table to the application 

Correct Answer: A 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 66 When should a developer create a new tab in 

the Load Script? 

A. when the critical number of 255 lines per tab has been exceeded 

B. when the tab is marked with the ///tab$ statement 
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C. when portions of script are logically related 

D. when entering Edit Script for the first time 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 67 

Which QlikView feature should a developer use to provide information throughout the QVW application about how a field was calculated in the Load script? 

A. Field Tag 

B. Field Comment 

C. Dimension Tag 

D. Variable Comment 

E. Expression Comment 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 68 

A customer who operates a large national sales organization needs to divide a Sales.qvw document into region-specific documents using the Region field (North, South, East, and West). Each 

region should have access to region-specific data. 

Which instruction should a developer give to the Server/Publisher administrator to meet the customer's needs? 

A. create a QlikView Server task to reduce the Sales.qvw document based on the Region field and distribute to region-specific folders with appropriate file permissions 

B. create a QlikView Publisher task to reduce the Sales.qvw document based on the Region field and distribute to region-specific folders with appropriate file permissions 

C. create four QlikView Server tasks to reload data from the Sales.qvw document with data only for each region and distribute to region-specific folders with appropriate file permissions 

D. create a QlikView Publisher task to reduce data from the Sales.qvw document to create four QVX files with data only for each region and distribute to region-specific folders with appropriate file permissions 

Correct Answer: B 

Section: (none) 

Explanation 

Explanation/Reference: 

QUESTION 69 

A developer created two QVWs. The first QVW loads data from the data source and creates QVD files. The second QVW loads the QVD files and provides the user interface for the analytics. 

The customer does not have Publisher installed. 

How should the reloads be configured on the server to ensure the first QVW reload completes before the second QVW reload begins? 

A. Only the first QVW reload can be automated. An alert will need to be sent to prompt an administrator to manually perform the second QVW reload. 

B. Only one QVW reload can occur at a time on the QlikView server. The second QVW reload will always wait until the first QVW reload completes. 

C. The second QVW reload can be scheduled to start upon the successful completion of the first QVW reload. 

D. An action can be placed on the OnPostReload trigger within the first QVW to submit the reload of the second QVW. 

Correct Answer: C 

Section: (none) 

Explanation 

Explanation/Reference: 
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QUESTION 70 

A developer needs to modify the data model of a document that consumes 5GB of RAM when opened in memory. Which 

type of client should the developer use? 

A. Internet Explorer Plug-in client on a 64 bit Windows 7 operating system 

B. QlikView local client on a 32 bit Windows 7 operating system 

C. QlikView local client on a 64 bit Mac operating system 

D. QlikView local client on a 64 bit Windows 7 operating system 

Correct Answer: D 

Section: (none) 

Explanation 

Explanation/Reference: 
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